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Introduction to 5-Axis MultiBlade

Introduction to 5-Axis MultiBlade

This document explains the use of the GibbsCAM 5-Axis MultiBlade product. MultiBlade is the
preferred solution for machining impellers, blisks (bladed disks), and the like — parts that compress
or transport fluids.
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All members of the GibbsCAM 5-Axis family require 2.5D Solids or SolidSurfacer as prerequisite
products, and a 4-axis/5-axis post processor. The current MDD must be of type Mill, Mill/Turn, or
MTM.

MultiBlade Terminology

MultiBlade generates toolpath only for parts that contain one inner hub surface, one outer shroud
surface, blades (whose leading edge and trailing edge extend from hub to shroud), and fillets on
each blade.
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Each segmentincludes a left blade, a right
blade, and the items between them.

Hub surface, sometimes also called floor.
Main blade. The illustration shows the right
side of the left main blade for this segment.
Leading edge of the right main blade
Trailing edge of the right main blade
Fillet connecting the hub and the left side
of the right main blade
Splitter blade between the left and right
main blades
7. Shroud surface
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Activating MultiBlade Within 5-Axis

Within a 5-Axis process dialog, the following steps activate the user interface for MultiBlade:
1. Inthe Options tab, top pull-down menu: Select General.
2. Inthe Surface Paths tab, pull-down menu Calculation based on: Select Multiblade parts.

Result: The tabs in the process dialog change to the following: Options, Surface Paths, Part
Definition, Tool Axis Control, Link, and Edges.

MultiBlade Compared to Other Calculation
Strategies

Because MultiBlade is designed for impeller-type parts and nothing else, there is no need to spend
time extracting/untrimming floor surfaces or cross-sections, creating/copying/slicing/offsetting
surfaces, separating blades, and so forth.

The MultiBlade user interface knows exactly the types of surfaces your part must have, and it
supplies choices and parameters specific to impeller surfaces — blades arranged in a radially
symmetric pattern sitting on a central hub, machined using a sphere-tip tool (Sphere mill, Lollipop
mill, or Taper mill).
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Interface

User interface controls for 5-Axis MultiBlade are located in a process dialog with the following tabs:
Options; Surface Paths; Part Definition; Tool Axis Control; Link; and Edges.

Process #1 5-Axis Parameters

Optionz | Surfface paths | Part definttion | Tool axis control | Link | Edges

Calculation based on Mutti blade machining v | [Level 2
Pattem

+ The Options page presents exactly the same controls as for all other 5-Axis process dialogs,
such as feeds and speeds, coolant control, and patterns. Depending on your current MDD, it
may also present controls for rotary duplication or for spindle. Note that the Restore Defaults
button resets all 5-Axis controls, not just MultiBlade. For complete information, see 5-Axis
guide's information on the Options tab.

* The Surface Paths page, when Calculation based on is set to MultiBlade, presents controls for
setting the machining type and strategy, toolpath sorting method (such as one-way/spiral/zig-
zag) and cut direction, and parameters for toolpath layers and slices. For complete information,
see “Surface Paths tab for MultiBlade” on page 7.

» The Part Definition page presents controls for specifying the surfaces and segments to be
machined and for setting the machining quality. For complete information, see “Part Definition
tab” on page 12.

* The Tool Axis Control page, when Calculation based on is set to MultiBlade, provides a subset
of the regular 5-Axis tool axis controls for tilt angles and gouge check controls for tool
clearances. For complete information, see “Tool Axis Control tab for MultiBlade” on page 15.

» The Link page, when Calculation based on is set to MultiBlade, provides a subset of the regular
5-Axis controls for links between slices, links between layers, part clearance area, feed
distance, and home position. For complete information, see “Link tab for MultiBlade” on
page 18.

* The Edges page presents controls for handling surfaces for the leading edge (fluid intake) and
trailing edge (exit) surfaces. For complete information, see “Edges tab” on page 19.

The controls presented in the MultiBlade Surface Paths page let you set general toolpath parameters
for roughing and finishing operations, such as sorting and layers/slices.

Some settings on this tab have an effect on other portions of the interface. For example, if you
choose roughing or hub finishing, the Contour options are suppressed. Similarly, the Part
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Definitions tab lets you specify Shroud parameters only if you choose a roughing or blade finishing
for strategy that includes the shroud.

Advanced
Available only if you are licensed for 5-Axis MultiBlade Level 2. \When this checkbox is selected, the
interface changes in the following ways:

On the Surface Paths page:
- Under Pattern, the Machining pull-down menu offers Fillet finishing.

- Forroughing operations, under Rest material, you can specify Avoid incomplete layers or
Rough all layers.

On the Part Definition page:

- You can define stock and stock offset.

- Under Segments, you can specify several sorting options.
- Under Quality, you can control smoothing parameters.

On the Tool Axis Control page: Under Limits, you can specify a machine angle limit and
maximum angle step.

On the Edges page: Under Edge rolling, you can specify whether and how to trim the leading
edge and trailing edge.

Machining
This pull-down menu offers the following choices.

Roughing: Use this for operations that remove large amounts of material from shroud to hub,
using one of the options for Strategy.

Blade finishing: Use this for fine operations that finish main blades and splitters, using options for
Strategy and Contour.

Hub finishing: Use this for fine operations that finish the hub surface.

Fillet finishing: Use this for fine operations that finish the fillets between hub and blades, using
one of the options for Contour and specific settings for blade side and hub side described in
“Fillet Finishing” on page 12. Available only if you are licensed for 5-Axis MultiBlade Level 2.

Strategy
This pull-down menu, when available, offers the following choices.

Offset from hub: Each layer will be approximately parallel to the hub (inner) surface. For this
strategy, the shroud (outer) surface need not be a surface of revolution. Because the hub and
shroud surfaces are usually not parallel, layers that are offset from the hub will start to intersect
the shroud at some point. In this case, slices will be trimmed away so that they do not reach
over.
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Offset from shroud: Each layer will be approximately parallel to the shroud surface, which must
be a surface of revolution. Because the hub and shroud surfaces are usually not parallel, layers
that are offset from the shroud will start to intersect the hub at some point. In this case, slices will
be extended until they reach the hub surface edge.

Morph between shroud and hub: Layers will be interpolated to blend between inner and outer
surfaces, which must both be surfaces of revolution: layers closest to the hub will approximate
hub offsets, and layers closest to the shroud will approximate shroud offsets. In the Area
section, you can specify where the morphing starts and ends. In this case, cuts are neither
trimmed nor extended. Although this choice works well in most cases, chip load may diminish
on the trailing-edge side for blades whose leading edge is significantly longer than the trailing
edge.

Tip: Thin blades can benefit from extra passes. For example, for the outermost
60%, you might want to create a roughing operation using Offset from shroud

@ followed by a blade finishing operation. Then, for the remaining material, create a
roughing operation using Offset from hub followed by another blade finishing
operation.

The settings under Contour, for some finishing patterns, let you limit the extent of the toolpath
generated for the surfaces and segments specified in the Part Definition page.

This pull-down menu, when available, offers the following choices.

Full: Toolpath will be generated for all corresponding surfaces.

Full (trim trailing edge): Toolpath will be generated for all corresponding surfaces except the
trailing edge (exit) surfaces.

Full (trim trailing/leading edges): Toolpath will be generated for all corresponding surfaces except
the trailing edge (exit) and leading edge (fluid intake) surfaces.

Left side: Toolpath will be generated only for the left sides of surfaces you specify in Part
Definition.

Right side: Toolpath will be generated only for the right sides of surfaces you specify in Part
Definition.

Pocket (Blade finishing only): For each segment, toolpath will be generated only for the inner
sides of surfaces you specify in Part Definition.

The settings under Sorting allow you to control the cutter direction along the first slice and how it
changes direction with each subsequent slice, using the settings under Links between slices.

Method
This pull-down menu offers the following choices.
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*  One way, start from leading edge: Each cutter pass will move in the same direction, always
proceeding from the leading edge downward and outward to the trailing edge.

*  One way, start from trailing edge: Each cutter pass will move in the same direction, always
proceeding from the trailing edge upward and inward to the leading edge.

* Zig-zag, start from leading edge: The cutter will first proceed from the leading edge downward
and outward to the trailing edge. Then it will step over and continue machining in opposite
direction.

* Zig-zag, start from trailing edge: The cutter will first proceed from the trailing edge upward and
inward to the leading edge. Then it will step over and continue machining in the opposite
direction.

@ Warning: If no zig-zag path can be generated, a one-way path will be generated
instead.

Ordering
This pull-down menu, when available, offers the following choices.

* Leftto right: The first slice will be on the farthest left of the segment. Each subsequent slice will
be farther to the right.

* Right to left: The first slice will be on the farthest right of the segment. Each subsequent slice will
be farther to the left.

*  From center away: The first slice will be in the center of the area to be machined. Subsequent
slices will alternate sides proceeding away from the center. For zig-zag approaches, you also
specify Climb or Conventional.

Cut direction: Climb / Conventional
Using Conventional cut direction, the tool proceeds along the drive surface biting from the inside.
Using Climb cut direction, the tool proceeds along the drive surface biting from the outside.

The settings under Layers (for roughing or for blade finishing) allow you to specify either how many
outer-to-inner passes are made from shroud to hub, or else the depth-of-cut for each pass.

Tip: To visualize a trial toolpath most quickly and easily, set By maximum number =1
@ at first. Later, when you are satisfied with other settings and ready to generate final
toolpath, you can use a more realistic setting for Layers.

By maximum number
Specify the maximum number of layers to cut from shroud to hub.

By maximum distance / Distance
Specify the maximum depth-of-cut for each layer.

10
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The settings under Slices (for roughing or for hub finishing) allow you to specify either how many
edge-to-edge passes are made between blades, or else the stepover distance from one slice to the
next.

By maximum number
Specify the maximum number of slices to cut from one blade to the next, considering splitters as
blades.

By maximum distance
Specify the maximum stepover from each slice to the next.

The settings under First slice (for roughing only) allow you to specify different settings when the
cutter enters a new layer for the first time.

Number of intermediate slices
Specify the number of passes to take when cutting the first slice.

First slice feedrate %
Optionally, you can specify a slower feedrate for the first slice, as a percentage of the general
feedrate setin the Options page.

The settings under Area become available for roughing or for blade finishing when using the
strategy Morph between shroud and hub.

Start at(%)
Specify the percentage of blade length from the hub where the morphing starts.

End at(%)
Specify the percentage of blade length from the shroud where the morphing ends.

Available only if you are licensed for 5-Axis MultiBlade Level 2.
The options under Rest material (for roughing only) allow you to choose between the following.

* Avoid incomplete layers: Choose this option if you want to skip layers that were incompletely
machined in the previous pass.

* Rough all layers: Choose this option if you want to machine all layers, even those that were only
partly machined in the previous pass.

11
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Fillet Finishing

Available only if you are licensed for 5-Axis MultiBlade Level 2. Use this pattern to generate a

finishing toolpath on the fillet area between hub and blade. The system finds the fillet surfaces
automatically. You can define the area to be machined for the hub and blade sides of the fillet

independently or together.

Area
The settings under Area allow you to how the blade-side portion of the fillet will be machined.

* By number of cuts: With this option, you specify how many blade-side cuts to make and, under
Both Sides, a stepover distance.

Number of cuts
Specify the number of blade-side cuts for the fillet.

* By big tool diameter: With this option, you use the tool diameter under Both Sides to determine
which blade-side fillet areas were unreachable by the roughing tool, and you can also specify
blade overlap.

Blade overlap

By maximum number

The controls presented in the MultiBlade Part Definition page let you specify the surfaces and
segments to be machined and set the machining quality.

12
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Blades,splitterfillets / Stock to leave

Blades, such as main blades (2) and splitters (6), are usually free-form surfaces with a double
curve. Fillets (5) are part of the blade. Each blade has a leading edge (3) and a trailing edge (4): the
leading edge is the suction side for the transported fluid, and is usually rounded; the trailing edge is
the exhaust side, usually corresponding to the stock geometry.

For roughing and hub finishing, you specify the left main blade and right main blade for the
segment, and optionally one or more splitter blades between them. For blade finishing, you specify
only the blade or splitter you want to machine. For roughing or blade finishing, you must also specify
all associated fillets.

To specify main blades (2,3,4), splitter blades (6), and fillets (5): Click the ellipsis button ([ -]); then,

in the Select Surfaces dialog, select a surface (or CTRL-select multiple surfaces) in the workspace,
and click OK to return to the process dialog. Enter a value for the amount of stock to remain
unmachined.

Hub / Stock to leave
The hub surface (1), also called the floor surface, is the inner surface, and must be a surface of
revolution. The blades and splitters sit upon it.

To specify the hub (1): Click the ellipsis button and, in the Select Hub Surfaces dialog, select any
inner surface that adjoins both a leading-edge fillet and a trailing-edge fillet (you do not need to
select all surfaces of the entire 360-degree hub, but you must also select the "collar" above the
leading-edge fillets if it exists), and then click OK. Enter a value for the amount of stock to remain
unmachined.

13
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Shroud / Stock to leave
The shroud surface (7) is the outer surface. It is usually the same as revolved-surface stock, but it
can be a free-form surface if you are roughing using Offset from hub strategy.

To specify the shroud (7), click the ellipsis button and, in the Select Shroud Surfaces dialog, select
any one of the small outer surfaces that adjoins both a leading edge and a trailing edge (you do not
need to select all surfaces of the entire 360-degree shroud), and then click OK. Enter a value for the
amount of stock to remain unmachined.

Check surfaces / Clearance

Select this checkbox if you want to specify a clearance value for one or more additional check
surfaces. For example, when you are finishing a splitter, you might specify blade faces as check
surfaces.

Stock definition / Stock offset
Select this checkbox if you want to specify a body for rest material. Wherever no stock is defined, no
toolpath will be created. Available only if you are licensed for 5-Axis MultiBlade Level 2.

Rotation axis
If the system cannot automatically detect the axis of rotation, you can define it yourself.

«  For rotation axis: Select User defined and click the ellipsis button ([__]); then, in the Rotary Axis

Selection dialog, specify XYZ values for the orientation vector (or click the ellipsis button, select
a line, and click OK) and then click OK.

«  For rotation axis base point: Click the ellipsis button ([ .]); then, in the Rotary Base Point

dialog, specify XYZ values for the base point (or click the ellipsis button, select a point, and click
OK) and then click OK.

Number of segments
Specify the total number of segments in the impeller or blisk.

A segment is a portion of the part from one main blade to another. For example, if a part consists of
eight segments, it has eight main blades.

Machine
Specify how many segments should be machined by the current operation.

Tip: To visualize a trial toolpath most quickly and easily, set Determined number =1 at
@ first. Later, when you are satisfied with the toolpath for one segment, you can
increase the number or change the setting to All.

Start angle
To specify the start position of the toolpath, either identify the segment number (At segment) or
supply an angle (User-defined).

Direction
When you are machining multiple segments, you can specify whether to proceed clockwise or
counterclockwise. (This is independent of the slice ordering within a single segment; see “Sorting

14
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Settings” on page 9.)

Sort by
Available only if you are licensed for 5-Axis MultiBlade Level 2\When you are machining multiple
segments, you can specify:

* Complete segment: To machine the slices in all layers in the current segment before proceeding
to the next segment.

* layer: To machine all slices in the current layer in all segments before proceeding to the next
layer.

+ Slice: To machine one slice in the current layer in all segments before proceeding to the next
slice.

Machining tolerance
Specify an overall tolerance for the entire toolpath.

Tip: When generating trial toolpath for visualization, set a fairly loose tolerance
value at first, such as 0.005 inches or 0.1 mm. Later, when you are satisfied with the
@ toolpath for one segment, you can tighten the tolerance to a more realistic value.

Warning: Setting too loose a tolerance can cause toolpath calculation to fail,
especially for fillet finishing.

Splitter flowline smoothing

Available only if you are licensed for 5-Axis MultiBlade Level 2. Drag the slider or use the arrow
keys to specify how much to smooth the toolpath as it moves aside for the splitter. The lowest
setting of 8% would leave less stock, but it can create jerky toolpath with acute angles. A high
setting, such as 20%, would create much smoother toolpath that leaves more stock at the leading-
edge fillet of the splitter.

Tool axis smoothing

Available only if you are licensed for 5-Axis MultiBlade Level 2. Drag the slider or use the arrow
keys to specify how much to smooth the variations in tool axis tilting. The object is to minimize tilting
without gouging the part.

The controls presented in the MultiBlade Tool Axis Control page provide a rearranged subset of the
regular 5-Axis tool axis controls for tilt angles and gouge check controls for tool clearances.

The settings under Tilting specify tool axis angles with respect to the hub normal vector.

Strategy
At this release, the only strategy offered is Global lead angle.

15
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Global lead angle Dynamic lead angle
When you use Dynamic lead angle as your tilting strategy, you can specify values for:
* Preferred lead angle (same as Global lead angle): Specify a preferred forward tilt angle for the
tool, relative to the hub surface, in the cutting direction.
*  Minimum lead angle: The minimum amount that the tool axis can tilt forward.
* Maximum lead angle: The maximum amount that the tool axis can tilt forward.

As the illustration indicates, these parameters let you vary lead angles as needed for machining in
cramped locations.

Side tilt angle
Specify the maximum angle for the tool to tilt to the side of the cutting direction, towards the
blades, to avoid gouging. At @ degrees, the tool will be oriented perpendicular to the hub
surface.

Tilt around toolpath
Available only for roughing.

Available only if you are licensed for 5-Axis MultiBlade Level 2.

Machine angle limit

If your machine has limitations on tool angle, select this checkbox and enter the maximum angle
that the tool is allowed to tilt. If this limit prevents the tool from reaching some areas of the toolpath,
then that portion of the toolpath will be trimmed.

Maximum angle step

This value sets the maximum allowed angle change between two adjacent toolpath positions; it
must be greater than @ degrees. The toolpath calculation will prevent any tool axis vectors from
having an angle change greater than the value specified.

Maximum angle step for rapid moves
This value sets the maximum allowed angle change between two adjacent rapid moves.

16
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Tip: Decreasing the value for Maximum angle step generates more points; increasing
it generates fewer points.

{D Warning: Collisions are checked only attool positions, not between positions.
Therefore, if Maximum angle step is set to a large value, the system might not detect
some collisions between positions. If this occurs, use a smaller value here.

The system looks at the holder back, holder front, and shaft as simple cylinders, no matter what the
shape actually looks like. These clearances are a virtual stock added to the diameters of your holder
back, holder front, and shaft.

If the surfaces specified in the Part Definition tab have a value set for Stock to leave, then the
clearance and Stock to leave values are added together to keep the holder front away from the part
by that distance. For example, if the holder front clearance is 0.2 and you set Stock to leave to 0.5 on
the surfaces, then the holder front is not allowed to come closer than 0.2 + 0.5 = 0.7 to the part.

Example: Cylindrical clearances.
For cylindrical clearances, you specify three linear values: One for the shaft diameter, one for the
holder front diameter and length, and one for the holder back diameter and length.

Clearances - Cylindrical

4

3 1. Flute
2. Shaft

- 3. Holder

B Front
4. Holder

—_— Back

1 \ \ \

2A = Shaft diameter clearance; 3A = Holder Front clearance; 4A = Holder Back clearance

Clearance angle
Specify a minimum clearance angle between blade and tool.

m a = Clearance angle between blade and tool

17
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The controls presented in the MultiBlade Link page provide a subset of the regular 5-Axis controls
for links between slices and links between layers, in addition to parameters for part clearance area,
feed distance, and home position.

Automatic
If you want to keep the default system values (recommended), keep this checkbox selected.
Clearing the checkbox allows you specify nondefault settings for all of the following.

The choices for Link between cuts and Links between slices (available only when By maximum number is
greater than 1 under Surface Paths > Layers) refer to settings farther below on the Link page.
Each slice is a cut approximately parallel to the blades, proceeding from one edge to the other.
Each layer is a series of cuts where the entire set proceeds inward from shroud to hub.

If you clear the Automatic checkbox, choose an option from the pull-down menu to specify how to
link from one cut (or slice) to the next:

» Choose Direct line to proceed directly from the end of one cut to the start of the next, optionally
with a plunge arc.

* Choose Blend spline to blend the lead-out of the last cut into the lead-in of the next, optionally
with a plunge arc.

+ Choose Feed distance to retract by the value specified in the Distances settings described below,
optionally with a plunge arc.

» Choose Clearance to retract to the location implied by the Clearance settings described below,
optionally with a plunge arc.

Use
Choose whether to use a cylindrical or spherical clearance envelope around the part.

Sphere / Cylinder radius
Specify a value measured from the rotary center of the part.

Sphere center height
Specify a value the places the center of the sphere at the center of the part (height=0) or above or

below it (positive or negative).

Autodetect dimension and position
By default, this checkbox is selected, causing the system to calculate the radius. If you clear the
checkbox, manually specify a value for Cylinder radius.

18
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Feed distance
Specify how far to retract the tool from the drive surface before approaching the next cut.

Start from home position
Select this checkbox to make the tool start from the home position you designate below.

Return to home position
Select this checkbox to make the tool return to the home position you designate below.

XIYIZ
You can enter XYZ values for the home position, or you can click the ellipsis button ([-]) and then,

in the Select Home Position dialog, select a point and click OK to return to the process dialog.

The controls presented in the MultiBlade Edges page give you control over the tool behavior at the
leading edge and trailing edge of the blade and the trailing edge of the splitter. Usual practice is to
use Edge rolling to trim the toolpath back from the edge by at least a half tool radius, and then to use
Edge extension to extend the toolpath slightly past the edge.

Edge rolling
Full (without trimming): The tool will roll around the entire leading/trailing edge over to the other side
of the blade. Available only if you are licensed for 5-Axis MultiBlade Level 2.

Auto (trim by tool radius): Toolpath will be trimmed when the radius of the leading edge or trailing
edge exceeds the tool radius. Available only if you are licensed for 5-Axis MultiBlade Level 2.

Trimmed by length
Specify how far back to trim the toolpath at the leading edge and trailing edge.

Trimmed by angle Available only if you are licensed for 5-Axis MultiBlade Level 2.

Imagine the leading edge and trailing edge extended in their natural directions. Take this vector and
specify an angle away from it in direction of the cutting side. Trimming occurs when the angle you
specify is reached.

Tangential
Tangential extension means that the toolpath is extended in the cutting direction.

Radial
Radial extension means that the toolpath is extended at the leading edge directly towards the
center of rotation, and extended at the trailing edge directly away fromiit.

19
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Available only if you are licensed for 5-Axis MultiBlade Level 2.

Keep tilt angle within distance

20
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Using 5-Axis MultiBlade

This part of the documentation covers the following areas:

Getting Started with MultiBlade — Provides general guidance on steps to take for programming
an impeller or blisk using 5-Axis MultiBlade.

“Sample Part: MultiBlade Impeller” on page 23 — Provides specific examples of typical actions
and settings for the sample partMultiBlade Sample Impellerl mm.vnc.

Getting Started with MultiBlade

After you open an impeller or blisk part, choose a sphere-tip tool (Sphere mill, Lollipop, or Taper
mill), create a 5-Axis process, and set material/feeds/speeds, usual practice is as follows.

1.

First, in the Surface Paths page: Activate Calculation based on MultiBlade; under Pattern,
choose Roughing and Morph between shroud and hub (with one exception: if the shroud of your
partis not a revolved surface, your choice for Strategy must be Offset from hub). You can come
back later and change your choices after you see results.

Under Layers, specify By maximum number = 1 for now. When you are close to completing the
Roughing operation, you will come back and change this to a realistic value.

Next, in the Part Definition page: Define the drive surfaces for one segment (hub,
blades+fillets, and so forth) and specify the total Number of segments in the part.

Under Segments, for Machine, set Determined number = 1 for now (you will come back and
change this).

Under Quality, enter a loose value for Machining tolerance for now, such as @.1 mm or 0.005
inches. (You may need to tighten this to avoid gouging.) When you are close to completing the
Roughing operation, you will come back and change this to a realistic value.

If you are performing rest machining from an existing body, select Stock definition, choose the
stock surfaces, and supply a value for Stock offset. Available only if you are licensed for 5-Axis
MultiBlade Level 2.

Next, in the Tool Axis Control page: Under Clearances, specify realistic values for the current
tool.

For now, under Limits, specify a fairly large Maximum angle step of 3 or 5 degrees. Later, you
might decrease this value in order to generate more tightly controlled toolpath.

Generate the operation (one segment, one layer, several slices). Render it and inspect the
preliminary results.
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Refine settings as needed. For example:

If you misdefined any portion of the part or check surfaces, return to the Part Definition tab
and CTRL-select to add or remove surfaces. For example, the hub should also include the
small “collar” surface just above the leading edges.

If gouging is occurring, try one or more of the following, depending on what you see:

= Inthe Part Definition and Tool Axis Control pages, supply larger values for Stock to
leave and offsets/clearances.

= InPart Definition, supply a tighter value for Machining tolerance.
* InTool Axis Control, supply a smaller value for Maximum angle step.

= InLink, supply a more generous value for Clearance or Feed distance.

Repeat the previous step as needed, generating and rendering toolpath for one layer of one
segment, until you are pleased with the result. If appropriate, experiment with one or more of
the following:

In Edges: Supply values for Edge Rolling (to trim back toolpath) and Edge Extension (to
smoothly extend toolpath), fine-tuning tool behavior at the leading edges and trailing edges
of the blades and splitters.

In Part Definition: Under Quality, try adjusting the sliders for smoothing. Available only if
you are licensed for 5-Axis MultiBlade Level 2.

In Surface Paths: Try out different choices under Sorting.

In Surface Paths: Try out different values under Slices and possibly Area.
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7. When you are fully satisfied with the toolpath for one layer of one segment: In Surface Paths,
under Layers, increase By maximum number) to 2 or 3. In Link, choose a method for Links
between layers. Regenerate the toolpath. Experiment as needed with other values and methods.

8. InPart Definition, under Segments, set Determined number to 2 or 3, and specify choices for
Start angle and Direction. Regenerate the toolpath. When you are satisfied, increase
Determined number to equal the value for Number of segments.

You might also want to experiment with choices for Sort by to see which one maximizes the
production for a particular setup. Available only if you are licensed for 5-Axis MultiBlade Level 2.

9. Asneeded, in Surface Paths, try out realistic values under Layers and Slices, possibly
adjusting other settings such as offsets/clearances/tolerances in Part Definition, clearances in
Tool Axis Control and Link, and choices for linking between and slices and layers and sorting
them.

Because multiple passes (under Layers) and low values for Machining tolerance
@ increase CPU usage, these are usually the last parameters you will change as you
complete your Roughing operation.

10. After you complete your Roughing operation, create new operations with Machining set to Blade
finishing and then to Hub finishing.

Also create operations for Fillet finishing as needed. Available only if you are licensed for 5-Axis
MultiBlade Level 2. Y ou will need to use a tool of much smaller radius, of course, and you will
also need to set a tighter value for Machining tolerance (in Part Definition, under Quality).

For tools of smaller radius, be sure to adjust settings appropriately for feeds and speeds (in
Options) and for offsets/clearances/tolerances.

Sample Part: MultiBlade Impeller

Sample parts are provided on the installation DVD. They can also be downloaded from
https://online.gibbscam.com (login required).

For 5-Axis MultiBlade, the sample part name isMultiBlade Sample Impellerl mm.vnc.
+ Step A: Open and Explore the Sample Part

* “Step B: Create and Set Up a 5-Axis MultiBlade Process” on page 24

+ “Step C: Provide Initial Settings for MultiBlade Processes” on page 25

» “Step D: Generate, Inspect, and Refine Initial Results” on page 26
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+ “Step E: Increase Layers and Segments, with Sorting” on page 29

» “Step F: Create Finishing Operations” on page 31

Step A: Open and Explore the Sample Part

1. Start GibbsCAM, navigate to the folder containing sample parts, subfolder 5-Axis
MultiBlade\, and open the sample part (MultiBlade Sample Impellerl mm.vnc.).

2. Open the tool list, the Machining palette, the Body Bag, and Feature Manager.
3. Temporarily change to Feature Color mode.

4. Become acquainted with the part and its component surfaces: hub, shroud, main blades and
splitter blades, fillets, and so forth.

5. When finished, change back to Gibbs Color mode.

% MultiBlade Sample Impellerl mm.vnc
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1. Machining palette

2. Feature Manager:
Feature #1 (orange): left blade
Feature #2 (pink): right blade
Feature #3 (green): splitter

3. Body Bag

Step B: Create and Set Up a 5-Axis MultiBlade
Process

1. Fromthe Tools List, drag the tile for Tool 1 onto the blank process tile. From the Machining
palette, drag the 5-Axis function tile onto the same process tile.

Feature Color (icon)

Hub surface

Shroud surface

Leading edges of blades
Trailing edges of blades
Fillets joining hub and blades

© o ~NO Ok

Result: The 5-Axis process dialog opens to the Options page.

24



Using 5-Axis MultiBlade

2. Inthe Options page: Click Restore Defaults, and then click Material. In the Materials dialog, click
Calc RPM and CalcFeed to populate values for feeds and speeds, and then close the Materials
dialog.

3. Click the Surface Paths tab. In the pull-down menu for Calculation based on, change from
Surfaces to Multi blade parts. Notice how the tabs to the right change: Three tabs disappear
(Gouge Check, Roughing, and Utility), and one new tab is added (Edges).

Step C: Provide Initial Settings for MultiBlade
Processes

1. Explore the Surface Paths settings. For example:

- Under Pattern, several strategies are available for Roughing and Blade finishing, and you can
specify choices and values for Layers.

- For Roughing and Hub finishing, you can specify choices and values for Slices.

- Fillet finishing offers a completely different set of parameters. Available only if you are
licensed for 5-Axis MultiBlade Level 2.

2. Before moving on to other tabs, set the following:
- Pattern/Machining: Roughing
- Pattern/ Strategy: Morph between shroud and hub

- Layers /By maximum number: 1
Although this is an unrealistic value, it simplifies visualization and greatly reduces the time
required to generate toolpath. Later, you will come back and set this to a more realistic
value.

3. Click the Part Definition tab and explore the settings. Before moving on to other tabs, set the
following:

- Blades,splitterfillets: Click the ellipsis button ([..]). When prompted to select impeller blade

surfaces, click all three of the lines in Feature Manager to select the surfaces associated
with the two main blades (Left Blade and Right blade) and splitter blade, and then click OK.
The blade surfaces are displayed in pale blue. Set an appropriate value for Stock to leave,
such ©.2 mm.

Tip: When using Feature Manager as a shortcut for selecting surfaces, double-
{D check the list shown in the Select [...] Surfaces dialog box to be sure it includes items of
type Face only and does not accidentally include curves or points.

- Hub: Click the ellipsis button ([._]). When prompted to select impeller hub surfaces, click the

large surface between any two blades, and CTRL-click the small “collar” surface just above
the leading edges of the main blades. Because the hub is a surface of revolution, the system
is now acquainted with the entirety of the hub and its fillets with the blades. The hub
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surfaces are displayed in pale green. Set an appropriate value for Stock to leave, such
0.2 mm.

- Shroud: Click the ellipsis button ([..]). When prompted to select impeller shroud surfaces,

click any one of the thin outer surfaces connecting leading edge to trailing edge. Because
the shroud is a surface of revolution, the system is now acquainted with the entirety of the
shroud and its intersection with leading and trailing edges of all blades. The shroud surfaces
are displayed in dark green.

- Number of segments: Set to 8 for this part, which has 8-fold symmetry.

- Segments/Machine: Choose Determined number and set to 1 for now. Later, you will
machine multiple segments and experiment with direction and sorting.

- Quality / Machining tolerance: .1 mm
Although this is an unrealistic value, it reduces the time required to generate toolpath. Later,
you will come back and set this to a more realistic value.

Click the Tool Axis Control tab and explore the settings. Under Clearances, specify realistic
values for the current tool, such as:

- Shaft:@.2mm

- Holder front: 0.5 mm

- Holder back: 2 mm

- Clearance angle: @ degrees

Next, in the Tool Axis Control page: Under Clearances, specify realistic values for the current
tool.

For now, under Limits, specify a fairly large Maximum angle step of 3 or 5 degrees. Later, you
might decrease this value in order to generate more tightly controlled toolpath.

Step D: Generate, Inspect, and Refine Initial Results

Generate the operation and render it. Rotate and zoom the preliminary results to inspect them
closely.
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s

1. Trimmed toolpath at leading edge should extend beyond the >
top of the hub.
In the Edges page, increase Edge extension for Leading edge.

2. Where toolpath divides for splitter, adjustments may be
needed.
In the Part Definition page, adjust the Splitter flowline smoothing.

3. Trimmed toolpath at trailing edge should extend beyond the
outermost hub.In the Edges page, increase Edge extension for
Trailing edge.
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4. No gouging should occur.>
In the Tool Axis Control page, tighten the values under Limits and
Clearances. In the Part Definition page, tighten the Machining
tolerance.
5. Fillet atleading edge of splitter should be rounded. 4
After you complete the Roughing operation, you will create operations '

for Blade finishing and for Fillet finishing.

6. Fillets near trailing edge of blades may need attention.
After you complete the Roughing operation, you will create an
operation for Fillet finishing.

7. Refine settings as needed. For example:

- Iftoolpath does not extend beyond the leading edge and trailing edge of the hub: In Edges,
supply positive values for Edge extension.

Leading Edge Trailing Edge Edge Extension

Tangential 3mm

Radial 2mm
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Tangential 1Tmm and Radial
3mm

- Toadjust toolpath as it divides approaching the splitter, use the Splitter flowline smoothing
slider in the Part Definition page:

= For closest approach to the fillet, decrease the smoothing.

= Toreduce jerky acute angles, increase the smoothing.

Fillet Close up Splitter flowline smoothing

Splitter flowline smoothing: 0.70%

Splitter flowline smoothing: 3.00%

Splitter flowline smoothing: 20.0%

- If gouging is occurring, try one or more of the following, depending on what you see:

= Inthe Part Definition and Tool Axis Control pages, supply larger values for Stock to
leave and offsets/clearances.

= InPart Definition, supply a tighter value for Machining tolerance.
* InTool Axis Control, supply a smaller value for Maximum angle step.

= InLink, supply a more generous value for Clearance or Feed distance.

Step E: Increase Layers and Segments, with Sorting

1. When you are fully satisfied with the toolpath for one layer of one segment:
- In Surface Paths, under Layers, increase By maximum number) to 2 or 3.
- InPart Definition, under Segments, increase Determined number) to 2 or 3.

- InLink, choose a method for Links between layers.
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2. Regenerate the toolpath. Experiment with other methods for the following:

- InPart Definition, under Segments, see the effect of trying a different method for Sort by.
Maybe also try changing Direction.

- In Surface Paths, under Sorting, experiment with different methods for starting and joining
the slices and for ordering the slices.

- InLink, try out other choices for Links between slices and Links between layers.

- Tryout the idea of taking two or more roughing passes, where the first one leaves stock on
the blades/splitters/fillets, uses a looser Machining tolerance and fewer slices, and machines
only part of the area. In the last roughing pass, use a large number of slices and specify
Zig zag as the sorting method.

Sample Options: Two Successive Roughing Operations

For both operations:
Pattern / Machining = Roughing;
Segments / Machine Determined

number = 2

Start Atsegment = 1;

Links: Automatic

. 2. (yellow):
1. (silver): Layers /By maximum distance = 5 mm
Layers / By maximum distance = 2 mm Slices / By maximum number = 10
Slices / By maximum number = 4 Sorting / Method: Zig-zag
Area/ St_ar.t_at = 60%; Part definition / Stock to leave =
Part definition / Stock to leave = 0.4 mm 9.1 mm
Quality / Machining tolerance = .1 mm Segments/ Sort by: Layer

Quality / Machining tolerance =
0.05 mm

3. Regenerate the toolpath as needed. When you are satisfied with your choices, generate
toolpath for the entire part with realistic values:

- InPart Definition, under Segments, change Machine to All and decrease Machining tolerance
t00.01 mm.

- In Surface Paths, under Layers, specify a realistic value for this part, such as By maximum
number = 15 layers total, or By maximum distance = 1 mm.

Because multiple passes (under Layers) and low values for Machining tolerance
@ increase CPU usage, these are usually the last parameters you will change as you
complete your Roughing operation.
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Step F: Create Finishing Operations

1.

After you complete your Roughing operation, create new operations with Machining set to Blade
finishing and then to Hub finishing.

Also create operations for Fillet finishing as needed. Available only if you are licensed for 5-Axis
MultiBlade Level 2. Y ou will need to use a tool of much smaller radius, of course, and you will
also need to set a tighter value for Machining tolerance (in Part Definition, under Quality).

For tools of smaller radius, be sure to adjust settings appropriately for feeds and speeds (in
Options) and for offsets/clearances/tolerances.
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Troubleshooting / FAQs

This part of the documentation is intended to answer questions of the following types.

Why Can’tl...?

Question. Why can’t | see or activate MultiBlade?
Licensing. 5-Axis MultiBlade is licensed separately from 5-Axis. If you do not have a license for 5-
Axis MultiBlade, you will not see it as an option in the regular 5-Axis interface.

Question. Why can’t | see or use 5-Axis MultiBlade Level 2 controls?

Licensing. 5-Axis MultiBlade Level 2 is licensed separately from 5-Axis MultiBlade Level 1. If you
do not have a license for 5-Axis MultiBlade Level 2, you will not see its capabilities within the
MultiBlade interface.

Checkbox. If you are licensed for 5-Axis MultiBlade Level 2, a checkbox (Advanced) appears near
the top of the Surface Paths page. If this checkbox is not selected, you will not see the Level 2
capabilities within the MultiBlade interface.

Question. Why can’t | use all tool types?
Tool Types. 5-Axis MultiBlade supports only sphere-tip tools: Sphere mills, Lollipop mills, and
Taper mills.

Question. Why can’t | see balloons or tooltips for MultiBlade controls?

Balloons. Instead of short balloon text, MultiBlade provides context-sensitive help: On the main
palette, click the question mark (or, on the Help menu, select Help On Item) and then click the
MultiBlade control to summon documentation for the interface item.

Tooltips. Tooltips are provided only for toolbars across the top of dialog boxes. The process
dialog for MultiBlade provides all controls within the tabbed pages without launching other dialogs.

HowDol ...?

General information on using 5-Axis MultiBlade and the sample part is supplied in “Using 5-Axis
MultiBlade” on page 21.

Question.How do |l ...?
5-Axis MultiBlade is a new product, and this section will be expanded as we learn more about
commonly asked questions.

Why Did It ...?

Question. Why did it take so long to load the part file?
Question. Why did the part file become so much bigger?

Most impeller and blisk parts, including the sample part provided for MultiBlade, make extensive
use of faceting. This saves CPU time at the expense of file size. To save space, the sample partis
saved without facets (3.5MB file size). Loading it requires a longer time to expand it to the faceted
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form (30MB). Depending on your preferences (File > Preferences > File tab > Save Size), you save the
model either as Large (the default) to minimize load time, or as Minimal (without facets) to minimizing
size on disk.

Question. Why did it take so long to generate toolpath?

Processing time depends most heavily on number of layers and on overall machining tolerance.
When you are planning the part programming, you can greatly reduce CPU usage by temporarily
setting Layers (By maximum number) to 1 and Quality to use a loose value for Machining tolerance.
The table shows how dramatically this can reduce CPU cost.

Time Layers Quality
186 By max number = 10 Machining tolerance = ©.01 mm
24 By max number = 10 Machining tolerance = .1 mm
16 By max number =1 Machining tolerance = 0.01 mm
2 By max number =1 Machining tolerance = 0.1 mm
In the Part Definition page, values for Stock to leave and Quality > Smoothing have little or no effect
on CPU usage. But when you machine multiple layers, the following can also reduce CPU timeto a
minor extent:

» Segments / Machine. To minimize CPU time, use Determined number = 1.
* Limits / Maximum angle step. To minimize CPU time, use a larger value, such as 3 degrees.

Question. Why did it generate One way toolpath when | specified Zig zag?

When you specify Zig zag and the system cannot satisfy all parameters for tolerances, stock, tool
tilting, angle limits, and so forth, it will first try to generate One way toolpath if it can do so. If it cannot
generate One way toolpath, it will display an error in the 5-Axis Task Manager.

Question. Why did context-sensitive help (Help > On Item) display the wrong topic?
The scope of the context is the control you click, such as a checkbox, option, or key-in area. No
general context is associated with items like page background or tab names.

Question. Why did it generate toolpath only near the leading edges?
Perhaps the Clearance angle (Tool Axis Control tab) is too large, preventing the tool from entering
tight regions.

Question. Why did it generate toolpath on only one segment half, between the right splitter surface
and the left blade surface?

Question. Why did ...?
5-Axis MultiBlade is a new product, and this section will be expanded as we learn more about
commonly asked questions.

Where Is Informationon ...?

You can find information within this document using the ToC (Contents) and Index. From within
MultiBlade, you can use context-sensitive context-sensitive help: On the main palette, click the
question mark (or, on the Help menu, select Help On Item) and then click the MultiBlade control to
summon documentation for the interface item.
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Question. Where is information on ...?
5-Axis MultiBlade is a new product, and this section will be expanded as we learn more about
commonly asked questions.
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Conventions

GibbsCAM documentation uses two special fonts to represent screen text and keystrokes or
mouse actions. Other conventions in text and graphics are used to allow quick skimming, to
suppress irrelevancy, or to indicate links.

Text

Screen text. Text with this appearance indicates text that appears in GibbsCAM or on your monitor.
Typically this is a button or text for a dialog.

Keystroke/Mouse. Textwith this appearance indicates a keystroke or mouse action, such as
Ctrl+Corright-click.

Code. Textwith this appearance indicates computer code, such as lines in a macro or a block of
G-code.

Graphics

Some graphics are altered so as to de-emphasize irrelevant information. A “torn” edge signifies an
intentional omission. Portions of a graphic might be blurred or dimmed to highlight the item being
discussed. For example:

Haole Manager completevnc I=l=E ! !
General |Commerrts | Machining Preferences I Machine Setup| l 04 A 01 T

Workspace | Interop Positions | Iulti-Part I Intermediate Tooling|
05 ji

-153.5 QJ

Annotations on a graphic are usually numbered callouts (as seen above), and sometimes include
green circles, arrows, or tie-lines to focus attention on a particular portion of the graphic.

Faint green borders that outline areas within a graphic usually signify an image map. In online help
or a PDF viewer, you can click a green-bordered area to follow the link.
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Links to Online Resources

Link

URL

Action / Description

http://www.GibbsCAM.com

Opens the main website for GibbsCAM.

https://online.gibbscam.com

Opens a restricted website containing materials
available for download. Requires a Gibbs CAM
Online Services account; to set up an account,
contact Gibbs CAM Support.

https://store.GibbsCAM.com

Opens the website for the GibbsCAM Student
Store.

https://macros.gibbscam.com

Opens a wiki containing documentation and
examples of GibbsCAM macros. Requires a
GibbsCAM account.

http://kb01.Gibbs CAM.com

Opens a Knowledge Base article, Contour
Operations Using Thread Mill Tools, that
explains in detail the correct way to program
Contour processes using Thread Mill tools.

mailto: Support@gibbscam.com

Runs your email client to create a new message
addressed to the CAMBRIO Technical Support
department for GibbsCAM.

mailto:Registration@gibbscam.com

Runs your email client to create a new message
addressed to the CAMBRIO Registration
department for GibbsCAM.

mailto: Sales@gibbscam.com

Runs your email client to create a new message
addressed to the CAMBRIO Sales department
for GibbsCAM.

http://www.autodesk.com/inventor

Opens an external website that provides more
information on Autodesk Inventor products.

http://www.celeritive.com

Opens an external website that provides more
information on VoluMill Ultra High-Performance
Toolpath (UHPT) from Celeritive Technologies.

http://www.predator-software.com

Opens an external website that provides more
information on a CNC editor and a virtual CNC
viewer from Predator Software, Inc.
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(tips and warnings) 17

Area (Blade side) 12

Area, settings in Surface Paths 11
Auto (trim by tool radius) 19
Automatic (parameters for Link) 18

Avoid incomplete layers (Surface Paths >
Rest material) 11
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Blade finishing
(setting) 8

Blade overlap (Fillet finishing) 12

blade, MultiBlade
defined and illustrated 5

Blades,splitter,fillets 13

blisks, MultiBlade 5

By big tool diameter (Fillet finishing) 12
By maximum distance (Layers) 10

By maximum distance (Slices) 11

By maximum number (Layers) 10

By maximum number (Slices) 11
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Check surfaces (Part Definition) 14
Clearance (Part Definition) 14
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Clearances, tool (Tool Axis Control) 17
Climb or Conventional (direction) 10
Complete segment (Sort by) 15
Contour, settings in Surface Paths 9
Conventional or Climb (direction) 10
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Direction (Part Definition > Segments) 14
Dynamic lead angle 16
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Edge extension 19
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Index: Edge tilting - MultiBlade, Level 2

Edge tilting 20
Edges tab 19
End at % (Surface Paths > Area) 11

F

Feed distance 19

Fillet finishing
(setting) 8
controls for 12

fillets, MultiBlade
defined and illustrated 5

First slice feedrate percent 11
First slice, settings in Surface Paths 11
From center away (Ordering) 10

Full (without trimming) 19

G

Global lead angle 16

H

Home position (Link tab) 19
Hub (Part Definition) 13

Hub finishing
(setting) 8

hub, MultiBlade
defined and illustrated 5

impellers, MultiBlade 5

K

Keep tilt angle within distance 20

L

Layer (Part Definition > Sort by) 15

Layers (Surface Paths)
(tips and warnings) 10

Layers, settings in Surface Paths 10

Lead angle
illustrated 16

Lead angle, maximum 16
Lead angle, minimum 16

leading edge of blade
defined and illustrated 5
settings in Edge page 19

Left to right (Ordering) 10
Link tab for MultiBlade 18

M

Machine (Part Definition > Segments) 14
Machine angle limit (Tool Axis Control) 16
Machining (Surface Paths > Pattern) 8

Machining tolerance (Part Definition
tab) 15

Maximum angle step (Tool Axis
Control) 16

Maximum angle step for rapid moves 16

Morph between shroud and hub
(setting) 9

MultiBlade
activating 6
prerequisites 5
purpose 5
terminology 5

MultiBlade tabs
Edges 19
Link 18
Part Definition 12
Surface Paths 7
Tool Axis Control 15

MultiBlade tips and warnings
angle step 17
collisions 17
quickly visualizing trial toolpath 10
selecting surfaces using Feature

Manager 25

strategies for thin blades 9
zig-zag paths 10

MultiBlade, Level 2
(summary of interface differences) 8
activating 8
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Index: Number of cuts (Fillet finishing) - Tilt around toolpath (Tool Axis Control)

N

Number of cuts (Fillet finishing) 12

Number of intermediate slices (First
slice) 11

Number of segments (Part Definition) 14

o)

Offset from hub
(setting) 8

Offset from shroud
(setting) 9

One way (Sorting) 10
Ordering, settings in Surface Paths 10

P

Part Definitiontab 12

Pattern, settings in Surface Paths 8

Q

quickly visualizing trial toolpath 10

R

Radial (edge extension) 19

Rest material, settings in Surface
Paths 11

Return to home position 19
Right to left (Ordering) 10
Rotation axis (Part Definition) 14

Rotation axis base point (Part
Definition) 14

Rough all layers (Surface Paths > Rest
material) 11

Roughing (Pattern > Machining) 8

S

segment, MultiBlade
(defined) 14

Shroud (Part Definition) 14

shroud, MultiBlade
defined and illustrated 5

Side tilt angle (Tool Axis Control) 16
Slice (Part Definition > Sort by) 15
smoothing (Part Definition tab) 15

Sort by (Part Definition > Segments) 15

Sorting (Surface Paths tab)
(tips and warnings) 10

Sorting, settings in Surface Paths 9
Sphere center height (clearance) 18
Sphere radius (clearance) 18
spherical clearance envelope 18
Splitter flowline smoothing 15

Start angle (Part Definition >
Segments) 14

Start at % (Surface Paths > Area) 11
Start from home position 19

Stock definition (Part Definition) 14
Stock offset (Part Definition) 14
Stock to leave (Part Definition) 13-14

Strategy (Surface Paths > Pattern)
(setting) 8
(tips and warnings) 9

Surface Paths tab, for MultiBlade 7
surface types required by MultiBlade 5

T

tabs, MultiBlade interface
Edges 19
Link 18
Part Definition 12
Surface Paths 7
Tool Axis Control 15

Tangential (edge extension) 19
Tilt around toolpath (Tool Axis Control) 16
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Index: Tool Axis Control tab for MultiBlade - Zig-zag (Sorting)

Tool Axis Control tab for MultiBlade 15
Tool axis smoothing 15

trailing edge of blade
defined and illustrated 5
settings in Edge page 19

Trimmed by angle (Edges tab) 19
Trimmed by length (Edges tab) 19

Z

Zig-zag (Sorting) 10
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